## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>1</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Guided Tour</td>
<td>1</td>
</tr>
<tr>
<td>Installation</td>
<td>5</td>
</tr>
<tr>
<td>System Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Installing Power Plus</td>
<td>6</td>
</tr>
<tr>
<td>Installing PNWRES92-I data files</td>
<td>6</td>
</tr>
<tr>
<td>Configuring Power Plus for the first time</td>
<td>7</td>
</tr>
<tr>
<td>Operation</td>
<td>9</td>
</tr>
<tr>
<td>Using Power Plus</td>
<td>9</td>
</tr>
<tr>
<td>Starting Power Plus</td>
<td>9</td>
</tr>
<tr>
<td>Selecting a Volume</td>
<td>10</td>
</tr>
<tr>
<td>Using the Browse Buttons</td>
<td>11</td>
</tr>
<tr>
<td>Shutting Down</td>
<td>11</td>
</tr>
<tr>
<td>Options and Configuration</td>
<td>12</td>
</tr>
<tr>
<td>Display</td>
<td>12</td>
</tr>
<tr>
<td>Options and File Access</td>
<td>12</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>16</td>
</tr>
<tr>
<td>Installation</td>
<td>16</td>
</tr>
<tr>
<td>Operation, File Access, and Configuration</td>
<td>17</td>
</tr>
<tr>
<td>Addendum/Notes</td>
<td>21</td>
</tr>
<tr>
<td>Tips on using Power Plus</td>
<td>21</td>
</tr>
<tr>
<td>Operational Characteristics</td>
<td>21</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>23</td>
</tr>
<tr>
<td>Index</td>
<td>27</td>
</tr>
</tbody>
</table>
Overview

Introduction

What is *Bonneville Power Plus*?

*Bonneville Power Plus* is a small but powerful custom Windows application developed for Bonneville Power Administration by AMPG (Applied Management & Planning Group) to make navigating PNWRES92-I (The Pacific Northwest Residential Energy Survey 1992 - Phase I) information fast and easy. A simple, hierarchical menu system allows you to find specific information with just a few mouse clicks or keystrokes. Browse Buttons let you move between documents with a single click of the mouse, or pop up a chart detailing the data you're viewing, then close the chart when you're done. *Bonneville Power Plus* (hereafter referred to simply as *Power Plus*) is your own personal assistant that will make accessing PNWRES92-I information fast and easy.

Why do I need *Power Plus*?

*Power Plus* will allow you to make the most effective use of your time when analyzing PNWRES92-I information. It will allow you to think in terms of "What data do I want to see?" instead of "Where's the file and what is it called?" It can save you hundreds, if not thousands, of keystrokes and mouse clicks every single day.

Guided Tour

This section will give you a quick overview of *Power Plus*’ main components to familiarize you with their appearance and the terminology we will be using to refer to them. For each of the main components we will have a picture of the component and a brief description of its function. Detailed information is available in the Operation section.
Volume Selection Window

The Volume Selection Window is the first, and most general, navigation tool available in Power Plus. You select which Volume of PNWRES92-I information you wish to access by clicking a button or pressing a hot-key (the Alt key with the underlined letter in the button caption).

When you make a selection, a more specific group of Volume Options will replace the main Volume Options. This approach allows you to "zoom in" on your data rather than offering an overwhelming number of options all at once.

Browse Buttons

The Browse Buttons allow you to step, sequentially, from one file to the next so you can browse related data. If you reach the beginning or end of the Volume you are viewing, Power Plus will automatically move to the next or previous Volume.
The Chart Button will open the chart associated with the current data (Table), at which time the picture and caption of the button will change (see below). Pressing the button again will close the chart and reveal the data (Table) again.

It is also possible to open and close Charts manually in Excel. If you open a Chart manually then you should also close it manually. If you use the Chart Button to open the Chart then you should also use the Chart Button to close the Chart otherwise Power Plus will be out of sync with Excel and the Chart Button will not operate as expected.

**To Open a Chart manually in Excel**

1. While you are viewing a table, locate the Chart in the current table by scrolling through the table until you find the chart. In Volumes C and D the Chart will be found below and to the right of the weighted data. In all other Volumes the Chart will be located directly below the weighted data.
2. Double-click on the Chart to open it.

**To Close a Chart manually in Excel**

1. Select the Chart Window by Single-Clicking anywhere within the window.
2. Double-click on the System Menu of the Chart window

   OR

   From the System Menu of the Chart window select Close.

**Topic Menu**

The Topic Menu, which sits at the top of the screen, allows you to jump to any topic in the current Volume simply by selecting it. The Topic Menu allows you to move quickly between unrelated topics. The choices available to you are context sensitive, which means that they will change automatically to reflect the options available in the current Volume.

**NOTE:** If the Topic Menu does not appear as it does here then you may need to use a different video driver with your Windows configuration. With certain video drivers the last menu option (Demographic) may not be displayed properly. If this occurs try switching to the VGA driver that came with Windows.
Moving between *Power Plus* Windows

You can click on any *Power Plus* window at any time with the mouse or you can move from window to window by pressing Ctrl+F6. When a window becomes active, you will see its title bar change color just like any other Windows application with the exception being the Topic Menu. The Topic Menu has no title bar so it cannot possibly change its color. You simply need to be aware that if neither the Volume Selection Window or the Browse Button Window is active, then the Topic Menu is active.
Installation

System Requirements

In order to run Power Plus your computer system needs to meet certain minimum requirements. While Power Plus should run successfully on any system capable of running Microsoft Windows 3.1 we recommend that you use it on systems which meet the configuration requirements listed below to insure that its performance is adequate.

Note: While Power Plus may operate adequately on systems that do not meet the recommended minimum requirements we cannot guarantee its performance on such systems.

Hardware Requirements

- IBM or 100% compatible computer capable of running Windows 3.1 in Standard Mode or Enhanced Mode. Consult your Windows documentation for detailed information.
- Hard Disk with at least 1 megabyte of free space available* (*does not include space for PNWRES92-I data files)

Hardware Recommendations

- 386 or 486 processor
- 4 or more megabytes of RAM
- VGA or SVGA video system
- Microsoft Mouse or compatible pointing device

Software Requirements

- MS DOS 3.3 or later
- Microsoft Windows 3.1 or later
- Microsoft Word for Windows 2.0
- Microsoft Excel 4.0
Other Requirements

**Fonts installed on system:** Arial, Arial Narrow, MS Sans Serif, Times New Roman

In some instances *Power Plus* may substitute another font if the designated font is not available on the system. While *Power Plus* will still operate, the documents and applications may not appear as intended.

## Installing Power Plus

### Installing the Power Plus Application

We have provided a complete setup utility that will allow you to install *Power Plus* quickly and easily.

**To install Power Plus**

1. Start Windows if it isn’t already running.
2. Put the Installation disk in drive A.
3. Open the Windows Program Manager
4. From the File Menu select Run
5. Type A:\SETUP.EXE
6. Press the OK button or hit ENTER
7. Follow the on-screen instructions.

**NOTE:** Substitute Drive B for Drive A if the Power Plus installation disk fits Drive B instead.

**NOTE:** When you first start Power Plus after the initial installation you will be prompted for configuration information. The menu option allows you to change the information at a later time in case your system configuration changes.

See Also: Configuring Power Plus for the first time on page 7.

### Installing PNWRES92-I data files

When you receive *Power Plus*, all the PNWRES92-I data files are contained on floppy diskettes. You may opt to install some, or all, of the data files on your hard disk to improve performance. *Power Plus* will first look for the necessary file(s) on your hard disk and, if they are not found, it will attempt to find them on the floppy diskette.

In order for *Power Plus* to locate the PNWRES92-I data files on your hard disk, they need to be installed in specific directories. We have provided a utility to make this process as easy as possible. In order to use this utility, *Power Plus* should already be installed on your system.
To install PNWRES92-I files on your hard disk

1. Start Windows if it isn't already running.
2. Locate the Power Plus Program Group in Windows Program Manager.
3. Run the File installation utility by either
   - Double-clicking on the Install PNWRES92-I Files icon
   OR
   - Selecting the Install PNWRES92-I Files icon and pressing ENTER.
4. Follow the on-screen instructions.

If you want to find out how much disk space is available on the drive where you're installing the PNWRES92-I data files you can do so with the Windows File Manager. Simply select the drive letter of the drive where the data files are to be installed and select any directory on that drive. The amount of available disk space for that drive will be displayed in the Status Bar of the Windows File Manager.

Configuring Power Plus for the first time

When you start Power Plus for the first time you should take a few minutes to configure it for use with your particular system. We have made every effort to insure that Power Plus will operate on most systems with only minimal configuration information: where Excel and Word are located on your system and which floppy drive to use if the PNWRES92-I files are not installed on your hard disk. We also give you the option of tailoring certain aspects of Power Plus' performance to suit your personal taste. For example, you may choose to install specific PNWRES92-I data files on your hard disk to speed up file access.

To Locate Word and Excel on your System

1. From the Options Menu on the Volume Selection window select Setup...
   (You will then be presented with the Setup dialog box)
2. In the Applications frame, select the Word for Windows option button.
   - Type the full path specification (including file name) to Word for Windows in the Filename text box.
   OR
   - Press the Browse button and locate the file name using the dialog box which opens. When you press the OK button in the Browse dialog box the selected file, including path, will be placed in the Filename text box for you.
3. Select the Excel Option button (In the Applications frame)
   - Type the full path specification (including file name) to Excel in the Filename text box.
   OR
- Press the **Browse** button and locate the file using the dialog box which opens. When you press the **OK** button in the Browse dialog box the selected file, including path, will be placed in the Filename text box for you.

The **Reset Defaults** button (under the Filename text box) will set file specifications for Word and Excel to WINWORD.EXE and EXCEL.EXE with no path specification. These options will work if Word and Excel are located in directories listed in the Path statement in your AUTOEXEC.BAT file. If you get a message from **Power Plus** that says it is unable to locate Word or Excel then you will need to specify the full path in the Filename text box.

**To Select a Floppy Drive**

<table>
<thead>
<tr>
<th><strong>Note:</strong></th>
<th>If you have not closed the Setup dialog box you do not need to reopen it at this time.</th>
</tr>
</thead>
</table>

1. From the **Options** Menu on the Volume Selection window select Setup...
   (You will then be presented with the Setup Dialog Box)

2. Select the option button (A: or B: in the Floppy Drive frame) that correctly identifies the floppy drive where the PNWRES92-I data files can be located if not installed on the hard disk.
Using Power Plus

Starting Power Plus

*Power Plus* is launched exactly like all other Windows applications. We'll outline the necessary steps here for completeness. If you are familiar with the Windows environment then just launch *Power Plus* as you would any other Windows application.

**To Start Power Plus**

1. Open the Windows Program Manager
2. Open the Program Group that contains the *Power Plus* icon
3. Double-click on the *Power Plus* icon

OR

Single-Click on the *Power Plus* icon to select it and then press the ENTER key

When you start *Power Plus* the first thing you'll see is an animated opening screen containing general information relating to *Power Plus*. From this screen you may either continue executing the application or you may exit at this time.

**To Continue from the Opening Screen**

- Press ENTER or any alphanumeric key on your keyboard
- OR
- Click the left mouse button while the mouse is over the opening screen

**Note:** The Opening Screen provides a Press Any Key prompt as a reminder.

**To Exit the Program from the Opening Screen**

- Press the ESCAPE key on your keyboard
Selecting a Volume

The Volume Selection Window (see page 2) allows you to select which Volume you want to access simply by pressing the command button associated with that Volume. When you first start Power Plus, the Volume Selection Window will have the main choices listed for you.

- Exec. Summary, Methods, Appendices
- Item-by-Item Results
- Crosstabulations Region/Domains
- Crosstabulations Area Offices
- Crosstabulations States
- Crosstabulations Utility Types
- Non-Respondents
- Quit

When you press one of these buttons (with the exception of Non-Respondents and Quit) the current choices will be replaced by a new set of choices based on your selection. For example, if you choose Item-by-Item Results the new set of choices will be:

- Region/Domains
- Area Offices
- States
- Main Menu

The last choice, Main Menu, will reset the choices to those available when Power Plus is first started. With one exception, this is the format of the Volume Selection Window.

The exception is the menu for Crosstabulations Region/Domains. The choices here are numerous so a modified selection method was called for. The command buttons operate just as they do on every other window, but there are some extra option buttons (pictured below) which change the specific Volumes available from the command buttons based on the Utility Type selected.

When you select a Utility Type option button you will notice that the captions on the command buttons change to reflect the available Volumes. You will also notice that some of the command buttons become disabled when a certain Utility Type is selected. This is the correct behavior which occurs if a Volume is not available for the Utility Type selected.

To Select a Volume

- Click the desired command button.

OR
• Press the **hot-key** associated with the desired command button.

**OR**

• Press the **TAB** key until the desired command button has the focus, then press the **ENTER** key.

### Using the Browse Buttons

The functionality and operation of the Browse Buttons should be fairly obvious so we will cover those aspects which may not be readily apparent.

When you press the **Next** browse button **Power Plus** will automatically close the current document and open the next document for viewing. When you reach the last document in a Volume, **Power Plus** will move to the next available Volume and open the first document of that Volume. The **Previous** browse button operates in the same manner.

The **Chart** browse button will open and close the chart that is associated with the data in the current Excel table. The picture and caption on the **Chart** button will reflect what operation it will perform. If the picture of a chart is displayed and the caption reads "Chart" then pressing the button will **open** the chart. If the picture of a worksheet (table) is displayed and the caption reads "Table" then the chart will be closed and the current table will become visible once again.

**Note:** If you open the chart for viewing with the **Chart** button you must also close it with the **Chart** button in order for **Power Plus** to remain properly "in sync" with Excel. Conversely, if you open the chart manually then you should close the chart manually as well.

### Shutting Down

**Power Plus** offers three ways to exit the application for maximum flexibility.

• Press the **Quit** button on the Volume Selection Window when the main choices are displayed.

• From the **Options** Menu on the Volume Selection window select **Exit**.

• Select **Close** from the system Menu of any **Power Plus** window or double-click on the control box of any window.

**Note:** **Power Plus** will not close Word or Excel when it exits, you must close them manually. If **Power Plus** closed Word or Excel it would run the risk of losing any unsaved data in open documents.
Options and Configuration

Display

The following menu choices are available on the Options Menu in the Volume Selection Window.

Stay on Top
This selection allows the Power Plus windows to "float" on top of other windows that may be open. Turning this option on will prevent other windows from obscuring the Power Plus Menu and Browse Buttons.

Topic Menu
This selection allows the Topic Menu that sits at the top of the screen to be toggled on and off.

Browse Buttons
This selection allows the Browse Buttons to be toggled on and off.

Options and File Access

Locating Excel and Word on your System

To Locate Word and Excel on your System

1. From the Options Menu on the Volume Selection window select Setup...
   (You will then be presented with the Setup dialog box)
2. Select the Word for Windows option button (in the Applications frame)
• Type the full path specification (including file name) to Word for Windows in the Filename text box.

OR

• Press the Browse button and locate the file using the dialog box which opens. When you press the OK button in the Browse dialog box the selected file, including path, will be placed in the Filename text box for you.

3. Press the Excel Option button (In the Applications frame) and repeat steps 1 and 2.

See Also: Configuring Power Plus for the first time on page 7.

File Access

Installing PNWRES92-I data files on your hard disk

When you receive Power Plus, all the PNWRES92-I data files are contained on floppy diskettes. You may opt to install some, or all, of the data files on your hard disk to improve performance. Power Plus will first look for the necessary file(s) on your hard disk and, if they are not found, it will attempt to find them on the floppy diskette.

In order for Power Plus to locate the PNWRES92-I data files on your hard disk they need to be installed in specific directories. We have provided a utility to make this process as easy as possible. In order to use this utility, Power Plus should already be installed on your system. You may also install the data files with the Windows File Manager.

To install PNWRES92-I files on your hard disk using the supplied utility program

1. Start Windows if it isn't already running.
2. Locate the Power Plus Program Group in Windows Program Manager.
3. Run the File installation utility by either
   • Double-clicking on the Install PNWRES92-I Files icon
   OR
   • Selecting the Install PNWRES92-I Files icon and pressing ENTER.
4. Follow the on-screen instructions.

To install PNWRES92-I files on your hard disk using the Windows File Manager

1. Start Windows if it isn't already running.
2. Start Windows File Manager.
3. In an open File Manager window, select the floppy drive where the data files you wish to install are located.
4. Select the directory name of the Volume you wish to install by single clicking on it.
   (The directory name will be one of the yellow folders in the left hand column of the File Manager window.)

5. Press the F8 key or choose Copy from the File Menu.
   (At this point a dialog box will open asking you for the name of the directory you wish to copy the Volume to.)

6. Type the name of the destination directory in the box labeled To.
   (The name you type will normally be the name of the directory where Power Plus is installed.)

7. Press ENTER or click the OK button.

**Note:** Do Not change the name of the Volume directory when you copy it or Power Plus will not be able to locate the data files properly.

**Selecting a Floppy Drive**

If you choose not to install the PNWRES92-I data files on your hard disk, you may access them from the floppy diskette they were delivered on. In order for Power Plus to locate them, you need to tell it which floppy drive you wish to use.

**Note:** Power Plus will always look for the files on the hard disk before attempting to locate them on a floppy diskette.

**To Select a Floppy Drive**

1. From the Options Menu on the Volume Selection window select Setup...
   (You will then be presented with the Setup Dialog Box)

2. Select the option button (A: or B: in the Floppy Drive frame) that correctly identifies the floppy drive where the PNWRES92-I data files can be located if not installed on the hard disk.

**Removing Write Protection from PNWRES92-I data Files**

**To Disable Write-Protection on a file**

1. From the Excel File Menu select Save As...

2. Type the Filename in the dialog box.

3. Press the OK button in the dialog box.

**NOTE:** You must save the file under a new name. Power Plus will not allow you to overwrite its original PNWRES92-I files.
What does Save As... mean?

This operation saves a new document, or a new version of an existing document, in the file format and with the filename you specify. It is also used to save a file to a different drive or directory and to export files in another format.

Because the PNWRES92-I files are write protected you can't alter them in any way. Should you wish to make changes to a file you will first have to use the Save As command to save the file under a new name and then change that new file instead of the original. This method ensures that the PNWRES92-I files will always contain the correct information because they can't be altered.
Troubleshooting

Installation

The Setup Program won't run

- Make sure your system meets the minimum hardware and software requirements to run Power Plus.
- Make sure Windows is running in Standard or Enhanced Mode.
- Exit and restart Windows, then try running the Setup program again.
- If you cannot successfully install Power Plus on your system after taking these steps then contact technical support for assistance.

I can't install the PNWRES92-I data files on my hard disk

- Make sure you have enough room on your hard disk to install the desired files.
- Make sure the File Installation utility is installed on your system. If the File Installation utility has been removed from the system, or becomes corrupt, you may either reinstall it or manually install (see File Manager installation instructions on page 13) the PNWRES92-I data files on your hard disk.

I can't find Excel or Word on my system

- If your system is on a LAN, certain applications may be installed on a server rather than locally on your machine. You may need to look for Excel and Word on Networked drives.
- If you are not on a LAN then you may have to install Word and Excel on your system. Power Plus will not operate without Word and Excel.
Operation, File Access, and Configuration

**Power Plus won't start**

- Make sure *Power Plus* has not been removed from the system.
- If you receive error messages when you start *Power Plus* and then the application exits, make note of the error messages and contact technical support.

**Power Plus can't start Excel or Word**

- Make sure your configuration information is correct.
  See: Options and Configuration
- Make sure the application is installed on your system or available on the network you are using.

**Power Plus is looking for the PNWRES92-I files on the wrong Floppy Drive**

- Make sure your configuration information is correct.
  See: Options and Configuration

**Power Plus can't locate the PNWRES92-I files on my hard disk**

- Make sure the PNWRES92-I data files are located in the proper directory on your hard disk.
- Run a disk utility program to determine if the file(s) or your hard disk have become damaged in any way.

**Power Plus can't find a PNWRES92-I file on the floppy disk, but it is looking at the proper disk drive**

- Make sure you have the correct floppy disk, for the volume you wish to view, in the floppy drive.
- Make note of the name of the file(s) which can't be found and try to locate the file on the floppy disk using Windows File Manager. If the file does not exist it may have been deleted in which case you need to use the back-up diskettes to restore the file to the diskette.
- If the file exists on the diskette run a disk utility program to determine if the file(s) or diskette have become damaged in any way.

**Lots of "flashing" occurs on the screen when Power Plus opens a new file.**

Depending on the speed of your system and the amount of installed memory, there may be some delay as files are opened. When a new file is opened *Power Plus* sends
commands to Word and Excel much as if you had typed them at the keyboard. What this means to you is that you may be able to watch Word and Excel operate as they carry out these commands. You may see files opening and closing, menus being accessed, and dialog boxes appearing and disappearing. On a fast system these operations may just be perceived as flickers on the screen or not seen at all. This is normal behavior and is nothing to be concerned about.

Excel or Word are behaving incorrectly when they receive commands from Power Plus

- Make sure you are giving Excel or Word enough time to process the commands from Power Plus completely before attempting to browse the table or document manually. If you are trying to perform other activities on the system while Power Plus is issuing commands, they may be delivered to the wrong application.
- Make sure you have the correct versions of Word and Excel on your system. The required versions are listed in the System Requirements section.

The Volume Selection Window disappears behind Word or Excel.

*This is normal behavior for the Volume selection window. Due to the orientation and size of the Volume Selection Window it automatically moves behind the main application window so as not to obscure your view.*

- Simply click on the title bar of the Browse Buttons window and the Volume Selection Window will appear again.

The Chart button is out of sync with Excel.

You will need to synchronize Power Plus and Excel by manually opening or closing the chart once.

Word and Excel are left running after Power Plus has exited.

This is normal behavior. Power Plus was designed so that it would not close Word and Excel automatically. You may be using Word and Excel to work on other documents while using Power Plus. If we arbitrarily shut down these applications we would discard any unsaved documents you may have been working on, effectively losing your work. Power Plus has been designed to be as cooperative as possible with the way you work. This also allows you to use Power Plus to locate a particular piece of PNWRES92-I information and then shut it down so you can continue to work in Excel or Word even after Power Plus has been shut down.
Addendum/Notes

Tips on using *Power Plus*

**Bringing the Volume Selection Window to the top**

While *Power Plus* has a Stay On Top option to make sure the Topic Menu and Browse Buttons are always visible, the Volume Selection Window will drop behind the Word and Excel windows because of its size. We felt it was important to keep the screen as free from clutter as possible so the PNWRES92-I data would not be obscured.

When you want to see the Volume Selection Window again you can click anywhere on the Browse Buttons window or the Topic Menu. The **Title Bar** of the Browse Buttons window is a good choice as clicking there won't trigger any unwanted events.

**Operational Characteristics**

"*Flashing*" may occur on the screen when *Power Plus* opens a new file.

Depending on the speed of your system and the amount of installed memory, there may be some delay as files are opened. When a new file is opened, *Power Plus* sends commands to Word and Excel much as if you had typed them at the keyboard. What this means to you is that you may be able to watch Word and Excel operate as they carry out these commands. You may see files opening and closing, menus being accessed, and dialog boxes appearing and disappearing. On a fast system these operations may just be perceived as flickers on the screen or not seen at all. This is normal behavior and is nothing to be concerned about.

**Hourglass cursor stays on**

There is a know aberration that may cause the Hourglass cursor to remain on even after all necessary processing has been completed. This is most likely to occur when a file or chart is opened or closed. *Power Plus* is not altering the cursor itself so it is not possible to fix the problem at this time.
Glossary of Terms

386 or 486 processor
The 80386 and 80486 processors are manufactured by Intel and are the current industry standard 32 bit chips used in IBM and compatible computers.

Browse Buttons
The Browse Buttons allow you to step, sequentially, from one file to the next so you can browse related data. If you reach the beginning or end of the Volume you are viewing Power Plus will automatically move to the next or previous Volume for you.

command button
A button which initiates an activity. These are standard buttons which appear in many Windows applications. Examples would be the OK and Cancel buttons used in many dialog boxes. A command button that is followed by an ellipsis (e.g. Browse...) causes another dialog box to appear.

Control box
The Icon that opens the System Menu for the window. It is always at the left of the title bar.

Crosstabulation
A report that groups data from a database into categories and tallies, analyzes or compares the data in ways specified by the programmer.

Enhanced Mode
A mode in which Windows runs to access the virtual-memory capabilities of the 80386 processor. In this mode, Windows appears to use more memory than is physically available and provides multitasking for non-Windows applications.
Hard Disk
A disk that is permanently mounted in its drive. Also known as a fixed disk.

hot-key
A combination keystroke used to access menus and other components quickly by pressing the Alt, Shift, or Ctrl keys along with the character in the caption that is underlined.

megabyte of RAM
RAM is Random Access Memory that can be used by applications to perform necessary tasks while the computer is on.

A megabyte is approximately one million bytes.

option buttons
A small, round button that appears in a dialog box. Within a group of related option buttons, you can select only one.

PNWRES92-I

Standard Mode
A Windows operating mode that can be used with 80286, 80386, and 80486 computers. This mode provides access to extended memory and also enables you to switch between non-Windows applications, but it does not provide virtual memory or enable non-Windows applications to run in the background or in a window.

System Menu
A Menu that contains commands you can use to manipulate the window. Application icons and some dialog boxes also have a System Menu. To open the System Menu, you use the Control Box at the left of the title bar in a window, or you select an application icon. See also Control Box.

Title Bar
The horizontal bar that runs across the top of a window. It generally contains the name of the window (e.g. Power Plus). On many windows, the title bar also contains the Control box and Maximize and Minimize buttons.

Topic Menu
The Topic Menu, which sits at the top of the screen, allows you to jump to any topic in the current Volume simply by selecting it. The Topic Menu allows you to move quickly between unrelated topics.
VGA

Video Graphics Array - A video standard that provides a resolution of 640x480 pixels. SVGA (Super-VGA) can provide 800x600 pixel or 1024x768 resolution with anywhere from 16 to 16.7 million colors depending on the hardware being used.

Volume

For the PNWRES92-I study, a Volume is a collection of reports or crosstabulations for a specific geographic area or area office.

Volume Selection Window

The Power Plus window used to select which Volume of PNWRES92-I data you wish to view.
Index

A
AMPG 1

B
Browse Buttons 1, 2, 11, 12, 18, 21, 23

C
Chart Button 3, 11, 18
Configuration 5, 7, 12, 17
Configuring Power Plus 7

E
Excel 6, 12, 16-17

H
Hardware Requirements 5

I
Installing PNWRES92-I data files 6, 13
Installing Power Plus 6

P
PNWRES92-I 1, 24

S
Selecting a Floppy Drive 14
Software Requirements 5
System Requirements 5

T
Topic Menu 3, 4, 21, 24

Troubleshooting 16

V
Volume Selection Window 2, 4, 10, 11, 18, 21, 25

W
Word for Windows 6
Write Protection 14